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Chapter 1

Introduction

1.1. Introduction

      Polymers are large molecules or macromolecules made up of atoms linked by covalent bonds.
Polymers are synthesized when many monomers come together and react to form a single
molecular species. One common way for these monomers to combine is in a linear arrangement in
which each monomer is connected to two and only two other monomers. The main chain part of
linear polymers typically consists mostly of single covalent bonds. Because rotations about single
bonds are relatively easy, polymers will rarely exist as straight chains but rather will exist as random
coils. The contrast between a straight or extended polymer chain and a random coil polymer chain
is illustrated in Figure INTRO-1. (Note: all links beginning in the word “Figure” will show you a
picture. After viewing the picture, you can type ⌘B to return to reading the text).
      The application Lattice was designed to study the nature of random coil linear polymers. After
inputing various polymer properties which might effect the conformations of the polymer chains,
Lattice will simulate random coil polymers by generating random walks on a tetrahedral lattice.
These polymers can be plotted to get a feel for the appearance of random coil polymers. For each
polymer generated, Lattice will also quantify its size by calculating two simple size properties. The
first property is the end-to-end distance which, as illustrated in Figure INTRO-2, is the distance
from the beginning of the polymer chain to the end of the polymer chain. After generating many
polymer chains, Lattice will report the average end-to-end distance and also allow you to plot the
distribution of the end-to-end distances.
      The other size property calculated by Lattice is the radius of gyration which is the average
distance from each atom in the polymer to the center of mass of the polymer molecule. The end-to-
end distance and the radius of gyration both characterize the size of the polymer. For large random
coil polymers, it can be shown that these two properties are not independent. Instead, the mean-
squared radius of gyration is related to the mean-squared end-to-end distance by

               <s^2> = <r^2>/6

where s is the radius of gyration and r is the end-to-end distance. For short polymer chains and for
polymers whose chains do not resemble random coils, however, this relation may not be accurate.
      It is beyond the scope of this documentation to consider all the aspects of polymer
conformations. Instead, it is assumed that the user has studied polymer science and has a basic
understanding of polymer conformations (see References). For such students, Lattice was
designed for running computer experiments aimed at investigating polymer conformations. Using
various options commands, the user can set properties of the polymer chain such as the number of
bonds and the barriers to rotations about the single bonds (see Setting Simulation Parameters).
Lattice will then generate random polymers chains using these properties and one can
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experimentally study the types and size of the polymer conformations that result. This
documentation has information about the generation of polymer chains on a tetrahedral lattice (see
Polymers On A Lattice). This discussion includes the generation of polymers with no centers of
asymmetry (e.g., polyethylene, see Generating a Polymer Chain), polymers which have centers of
asymmetry (see Vinyl Polymers) and polymers consisting of more than one type of monomer (see
Copolymers).
      For readers anxious to begin using Lattice, you may skip immediately to the help topic Starting
Lattice. See the Developer help topic for information on the developer of Lattice and for an email
address for technical help.

Extended Polymer Chain

Random Coil Polymer Chain

Figure 1: Figure INTRO-1: Two polymer chains. The Chain on the left is a straight extended chain
polymer. The chain on the right is a more realistic picture of a polymer molecule as a random coil.

End-to-end distance

Figure 2: Figure INTRO-2: The end-to-end distance of a linear polymer is the distance from one end of the
polymer chain to the other end of the polymer chain.
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Chapter 2

Polymers On A Lattice

2.1. Polymers On A Lattice

      Lattice uses the Monte Carlo method to calculate the end-to-end distance and the radius of
gyration of linear polymer chains. In the Monte Carlo method, a series of random polymer chains
are generated using a random number generator. For each such chain, the end-to-end distance and
the radius of gyration are calculated. By averaging the results for numerous chains with
appropriately chosen weighting factors, the average results will converge to the correct values for the
polymer under investigation.
      In Lattice, realistic polymer chains are generated using a random walk technique in which the
steps of the random walk are confined to a tetrahedral lattice (also known as a diamond lattice). A
section of a tetrahedral lattice is shown in Figure LATTICE-1. A typical random walk which
represents a piece of a randomly generated polymer chain is illustrated by the dark lines connecting
the circles.
      We next consider the properties of the tetrahedral lattice. Each lattice site is connected to four
other lattice sites. The lines connecting the sites are all of constant length and the angle between any
two consecutive lines is constant and equal to 109.47˚. By confining our random walks to such a
lattice we are restricted to considering polymers with constant bond lengths and with constant bond
angles equal to 109.47˚. Fortunately, this restriction is not as severe as it might seem. The bond
lengths in many polymers are constant or close to constant, and the bond angles in many polymers
are often close to the tetrahedral lattice bond angle. The best example of a polymer which conforms
to the tetrahedral lattice is polyethylene (see Figure LATTICE-2). All bonds in the backbone of
polyethylene are carbon-carbon bonds. These bonds have constant bond length of 1.53 Å. Each
carbon atom in polyethylene is in a tetrahedral configuration (or sp^3 configuration) and therefore
all bond angles are close to 109.47˚. In reality, a careful examination of the structure of
polyethylene reveals that the carbon-carbon bond angles are slightly greater than 109.47˚ — about
112˚. This difference is probably small enough that a tetrahedral lattice representation of
polyethylene will be a reasonable approximation to the polymer structure.
      Like polyethylene, many other polymers have constant bond lengths and bond angles near
109.47˚. Some examples are given in Figure LATTICE-2. Each of these polymers can reasonably
be approximated by a random walk on a tetrahedral lattice.
      Some polymers have more than one type of bond and therefore more than one bond length
along the polymer backbone. Many polymers also have bond angles that are not equal to the
tetrahedral lattice angle. While these chains are not best simulated on a tetrahedral lattice, as long as
their bond angles are not too far from 109.47˚, and as long as the bond lengths do not vary
significantly, it should be possible to get at least qualitative understanding of the properties of these
polymers using random walks on a tetrahedral lattice.
      The above comments suggest that random walks on a tetrahedral lattice can be used to simulate
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many polymers. While tetrahedral lattice results can be expected to give qualitatively useful results,
however, there are important problems which can only be studied using random walks that are not
restricted to any lattice. The obvious question, therefore, is why does Lattice restrict its polymers to
a lattice? The answer is speed. By using a lattice, most calculations can be done using integer
arithmetic. If Lattice did not use a lattice, most of the calculations would require floating point
arithmetic which is much slower and is especially slower on personal computers such as the
Macintosh. The use of integer arithmetic versus floating point arithmetic speeds up the calculations
by an estimated factor of 100. Because Monte Carlo simulations require the generation of a large
number of chains before the results converge to the true results, it is important to use the fastest
possible simulation techniques.
      The next question is how to generate realistic polymer chains on the tetrahedral lattice. This
topic is discussed in Generating a Polymer Chain.

Figure 3: Figure LATTICE-1: A section of a tetrahedral lattice. The dark line connecting the circles is a
piece of a typical linear polymer chain on a tetrahedral lattice.
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Figure 4: Figure LATTICE-2: Some sample polymers that can be reasonably well simulated by
simulations on a tetrahedral lattice.
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Chapter 3

Generating a Polymer Chain

3.1. Generating a Polymer Chain

      A linear polymer chain with n bonds each of length l is simulated on a tetrahedral lattice by a
random walk of n steps using a lattice whose lattice sites are separated by a distance l. The starting
point for the random walk and its first step can be chosen arbitrarily. These choices merely serve to
locate the polymer chain in space. The second bond or step and subsequent bonds or steps must
each decide among three possible step directions. The three possible steps for bond i+1 are
illustrated in Figure GENERATING-1. Note that the fourth possible step direction which would be
to step back along bond i is forbidden by bond angle constraints.
      A different viewing perspective helps to show the differences among these three possible steps.
Imagine looking directly down bond i with bond i+1 in the foreground and bond i-1 in the
background (See Figure GENERATING-2). The three random walk steps can then be
characterized by the angle bond i+1 makes in this projected view with bond i-1. That angle, labeled
f in Fig. 5, is called the dihedral angle; it is formally defined as the angle that bond i+1 makes with
respect to the plane defined by bonds i and i-1. The three steps corresponding to the three dihedral
angles 180˚, -60˚, and +60˚ are called the trans state, the gauche- state, and the gauche+ state,
respectively.
      Constructing a complete random walk to simulate a polymer chain requires assigning each bond
to a trans, gauche+, or gauche- state. Furthermore the assignment of these states must been done
with realistic probabilities. 
      To assign realistic probabilities to each of the rotational states, we must account for differences
in steric interactions. As suggested by Figure GENERATING-2, we might expect that the
interactions between the substituents at the end of bond i+1 and substituents at the beginning on
bond i-1 will have a significant effect the bond state probabilities. Normally (although not always)
the steric interactions will be minimized in the trans state and we arbitrarily assign that state to the
ground state or a state of zero energy. The gauche+ and gauche- states bring two parts of the chain
separated by 3 bonds into close proximity. We set the energy of this 3-bond interaction in gauche+
of gauche- bonds equal to Eg. Knowing Eg, or the difference in energy between the trans and the
gauche states, and ignoring all other possible interactions, we can use Boltzmann weighting factors
to assign relative probabilities to the possible random walk steps:

            Relative probability of trans step: exp(-0/RT) = 1

            Relative probability of gauche+ or gauche- step: exp(-Eg/RT) = s

where R is the gas constant and T is the temperature in degrees Kelvin. At each step in our random
walk, we ask the computer to generate a random number between 0 and 1+2s. If that number is
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between 0 and 1 the next step is a trans step; if that number is between 1 and 1+s the next step is
gauche+; if that number is between 1+s and 1+2s the next step is gauche-.
      The comments in the previous paragraph ignore an important nearest neighbor interaction. If
two consecutive bonds are gauche+/gauche- or gauche-/gauche+ the resulting conformation leads
to severe steric interactions. A gauche+/gauche- conformation is shown in Figure GENERATING-
3. The first and fifth atom of this 4-bond conformation will see severe steric interactions. This effect
is known as the pentane effect. The random walk needs to account for the pentane effect and assign
relatively low probabilities of gauche+/gauche- or gauche-/gauche+ conformations.
      If bond i is in the trans state, the conformation of bond i+1 is picked using the relative
probabilities discussed above. If bond i is gauche+, we use new relative probabilities for
determining the state on bond i+1. We now call the ground state or zero energy state the two bond
conformation gauche+/trans. We let Egg be the energy for two consecutive gauche+ bonds relative
to the gauche+/trans state. Most evidence suggests that Egg is equal to Eg. We let Eg + Eg+/g- be
the energy of the gauche+/gauche- state relative to the gauche+/trans state. The Eg part is the 3-
bond interaction energy associated with gauche bonds and the Eg+/g- part is the 4-bond interaction
energy due to the pentane effect. The new relative probabilities for jumps after a gauche+ jump are:

            Relative probability of a trans step after a gauche+ step:
                                                            exp(-0/RT) = 1

            Relative probability of a gauche+ step after a gauche+ step:
                                                           exp(-Eg/RT) = s

            Relative probability of a gauche- step after a gauche+ step:
                                                           exp(-(Eg+Eg+/g-)/RT) = sw

where w = exp(-Eg+/g-/RT). For each step in our random walk which follows a gauche+ step, we
ask the computer to generate a random number between 0 and 1+s+sw. If that number is between
0 and 1 the next step is a trans step; if that number is between 1 and 1+s the next step is gauche+;
if that number is between 1+s and 1+s+sw the next step is gauche-. An analogous procedure is
used for steps that follow gauche- steps.
      To generate polymers as described above, one needs to specify the bond length, the number of
bonds in the chain, the 3-bond interaction energy in gauche+ or gauche- bonds (Eg), the 4-bond
interaction energy in gauche+/gauche- bond pairs (Eg+/g-), and the temperature. How to set these
parameters and how to use Lattice to do a simulation after those parameters have been are
described in Setting Simulation Parameters and Starting Lattice. First, you may want to read about
other types of polymers that can be simulated, namely Vinyl Polymers and Copolymers. These
types of polymers require some additional parameters including more steric interaction energies.
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Figure 5: Figure GENERATING-1: The three possible steps on a tetrahedral lattice. The steps can be
characterized by the dihedral angle f. The dark line is bond i+1 and the hatched bond is bond i-1.
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Figure 6: Figure GENERATING-2: A gauche+/gauche- conformation on two consecutive bonds
illustrating the pentane effect. The circled area highlights the location of severe steric interaction.
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Steric Interaction

Figure 7: Figure GENERATING-3: An all-trans portion of an atactic vinyl polymer. Dark lines indicate
atoms located in front of the plane of carbon atoms and dashed lines indicate atoms behind the plane of
carbon atoms.
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Chapter 4

Vinyl Polymers

4.1. Vinyl Polymers

      When a polymer has asymmetric centers, there are some new problems that need to be
considered that were not addressed in the previous discussion on homopolymers with no
asymmetric centers. Asymmetric centers may exist in two possible configurations (“d” or “ l ”
configurations). Due to the asymmetry, the steric interactions experienced by right handed rotations
(positive dihedral angle) or left handed rotations (negative dihedral angle) will differ. Unlike the
situation described previously, this difference will cause gauche+ and gauche- states to occur with
unequal probabilities. Although many different polymers have asymmetric centers, the simulations
in Lattice are limited to one important class of such polymers — the vinyl polymers. In this
chapter, the techniques used to generate random walks that simulate vinyl polymers will be briefly
discussed.
      Vinyl polymers are derivatives of polyethylene in which every other carbon atom has one
substituent other than hydrogen. Thus, vinyl polymers have the repeat-unit structure and three-
dimensional form that are shown in Figure VINYL-1. In that figure, R is the substituent group.
Some typical vinyl polymers are polyvinyl chloride (R = Cl), polyvinyl fluoride (R=F), polystyrene
(R=phenyl group), and polypropylene (R=CH(3)).
      The three-dimensional view given in Figure VINYL-1 shows an all trans section of a vinyl
polymer. Each substituent will either be in front of the plane of carbon atoms defined by the
polymer backbone or will behind the plane of carbon atoms. Its position relative to that plane
determines the stereochemical configuration of the asymmetric center. We designate asymmetric
centers with “R” in front of the plane as “d” groups and those with “R” behind the plane as “l”
groups. A stereoregular vinyl polymer is one in which all the asymmetric centers are “d” or all are
“l” groups and therefore all the “R” substituents are in front of or behind the plane of carbon
atoms. Stereoregular vinyl polymer chains are called isotactic polymers. If the “d” and “l” groups
occur at random (as illustrated in Figure VINYL-1), the polymer is called atactic. Finally, if the
“d” and “l” groups alternate, the polymer is called syndiotactic.
      In a manner analogous to the previous chapter, we consider the three-possible steps (trans,
gauche+, and gauche-). In vinyl polymers, however, the relative probabilities of the trans, gauche+
and gauche- steps now will depend on the stereochemistry of the nearby asymmetric centers. All of
the possible stereochemistries need to be considered. We begin by considering a bond that follows
a bond that begins with a “d” group. The three possible steps are illustrated in Figure VINYL-2.
The projected view looking directly down bond i with bond i+1 in the foreground and bond i-1 in
the background is given in Figure VINYL-3.
      The substituent group “R” produces some new steric interactions. In the trans and in the
gauche- states there is a gauche-like interaction between “R” and the main polymer chain. In the
gauche+ state there is little interaction with “R.” If we assign E-R/t to the gauche-like steric
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interaction between “R” and trans bonds and we assign E-R/g to the gauche-like interaction
between “R” and gauche- bonds, then the relative probabilities for trans, gauche+, and gauche-
bonds in the above stereochemical configuration will be:

            Relative probability of trans step:  exp(-E-R/t/RT) = hs

            Relative probability of gauche+ step:  exp(-Eg/RT) = s

            Relative probability of gauche- step: exp(-(Eg+E-R/g)/RT) = st

where h is the ratio of the gauche-like interaction in the trans state to the standard gauche interaction
(h = exp((Eg-E-R/t)/RT)) and t = exp(-E-R/g/RT). We can divide out the common factor of s
resulting in relative probabilities for trans, gauche+, and gauche- of h, 1, and t. At each step in our
random walk that follows a bond that begins with a “d” group, we ask the computer to generate a
random number between 0 and h+1+t. If that number is between 0 and h the next step is a trans
step; if that number is between h and h+1 the next step is gauche+; if that number is between h+1
and h+1+t the next step is gauche-.
      If the “d” group in the previous discussion was replaced by an “l” group, the relative
probabilities would be the same except that the probabilities for gauche+ and gauche- would be
switched. Therefore, the relative probabilities for trans, gauche+, and gauche- for a bond after a
bond that begins with an “l” group are h, t, and 1.
      A similar analysis can also be made for a bond that immediately follows a “d” or an “ l ”
group; i.e. for a bond that follows a bond that ends with a “d” or an “l” group. The results are
given in Flory (1969) (see References). The relative probabilities for trans, gauche+, and gauche-
for a bond immediately after a “d” group are h, t, and 1. The relative probabilities for trans,
gauche+, and gauche- for a bond immediately after an “l” group are h, 1, and t.
      As was done in the previous chapter, this first analysis of vinyl polymers only considered first
order interactions or the interaction between groups connected by 3 bonds. By analogy with the
pentane effect in the previous chapter, we need to consider second order interactions or interactions
between groups separated by 4-bonds. The 4 bond interactions are more varied and more
complicated than the simple pentane effect in the previous chapter. For each type of bond pair (t/t,
t/g+, t/g-, g+/t, g+/g+, g+/g-, g-/t, g-/g+, and g-/g-) we must consider two situations. First, there
may be an asymmetric group between the two bonds, or second, there may be asymmetric groups
on either end of the bond pair. For each of these two situations, we must consider all possible
stereochemical configurations of the asymmetric groups. The enumeration of all possible
interactions was done by Flory (1969) (see References). Here we briefly describe some of the
interactions. The reader is referred to Flory (1969) for a more detailed description.
      First consider a bond pair in which the asymmetric group is between the two bonds. The second
order interactions in this situation are between groups attached to symmetric groups (i.e., between
parts of the polymer chain). The second order interactions are therefore identical to the pentane
effect in completely symmetric chains as described in the previous chapter. These interactions are
independent of the stereochemical configuration of the asymmetric group. One new feature,
however, does arise when the “R” substituent is large and has more than one bond. Consider a
two-bond or articulated substituent “-R-R.” For all bond pairs except trans/trans bond pairs, the
second bond can find a low energy state in which there are no first or second order interactions (3-
bond or 4-bond interactions). In trans/trans bond pairs, however, some steric interactions will be
experienced. An “-R-R” type substituent between two trans bonds is illustrated in Figure VINYL-
4. The lowest energy location of the second R group is the one illustrated in Figure VINYL-4. The
other two possible locations involve pentane effect interactions and will therefore be at higher
energies. In this lowest energy state there is a gauche-like interaction between the second R group
and the trans/trans bond pair. We will assign E-R-R/tt to the energy of this interaction.
      Assigning Eg+/g- to the energy of the pentane effect interaction, we can write down all the
relative probabilities for steps immediately following an asymmetric group. These relative
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probabilities include both first order and second order interactions. For bonds after “d” groups,
the probabilities are:

            Relative probabilities when a trans bond precedes a “d” center
                  trans: ht*        gauche+: 1       gauche-: t

            Relative probabilities when gauche+ bond precedes a “d” center
                  trans: h            gauche+: 1       gauche-: tw

            Relative probabilities when gauche- bond precedes a “d” center
                  trans: h            gauche+: w       gauche-: t

where w = exp(-Eg+/g-/RT) and t* = exp(-E-R-R/tt/RT). The relative probabilities for bonds
immediately following an “l” group are identical to those above except that the probabilities for
gauche+ and gauche- bonds are interchanged.
      Lastly, we must consider bond pairs located between two asymmetric centers. Most of the
possible bond pairs involve pentane effect interactions. The pentane effect interactions may be
between the parts of the main polymer chain (e.g., in g+/g- or g-/g+ bond pairs), between the
substituent groups and the main chain, or between two substituent groups. One particular pentane
effect interaction in a trans/trans bond pair between two “d” centers is shown in Figure VINYL-5.
Although the various pentane effect interactions can be expected to have different energies, these
interactions are second-order interactions and we can expect to get a realistic simulation if we ignore
these differences and assign Eg+/g- to all pentane effect interactions. It is then merely a matter of
considering all possible bond pairs (t/t, t/g+, t/g-, g+/t, g+/g+, g+/g-, g-/t, g-/g+, and g-/g-) between
all possible pairs of asymmetric groups ( “dd”, “dl”, “ld”, and “ll”). All the required relative
probabilities will not be listed here. The interested reader is referred to Flory (1969) (see
References).
      The energy factors required to enumerate all the possible bond state probabilities in vinyl
polymers are:

            Eg: standard 3-bond gauche interaction between parts of the
                        main polymer chain.
            Eg+/g-: pentane effect interaction.
            E-R/g: the gauche-like interaction between “-R” and the polymer chain in 
                        gauche bonds.
            E-R/t: the gauche-like interaction between “-R” and the polymer chain
                        in trans bonds.
            E-R-R/tt: the gauche-like interaction between the groups two bonds away 
                        from the main polymer chain and trans/trans bond pairs.

      Before these energies can be used to determine the relative bond state probabilities the
stereochemistry of the nearby asymmetric groups must be specified. To accomplish this we
introduce one more parameter called the stereochemistry replication frequency. The replication
frequency is the probability that the next asymmetric center will have the same stereochemistry as
the previous asymmetric center. The replication frequency must be between 0 and 1. If the
replication frequency is 1 the polymer will be isotactic; if it is 0, the polymer will be syndiotactic;
for all other values the polymer will be atactic.
      How to set all the parameters for vinyl polymers and how to use Lattice to do a simulation after
those parameters have been set are described in Setting Simulation Parameters and in Starting
Lattice.
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Figure 8: Figure VINYL-1: Vinyl polymer repeat unit and an all-trans portion of an atactic vinyl
polymer. Dark lines indicate atoms located in front of the plane of carbon atoms and dashed lines
indicate atoms behind the plane of carbon atoms.
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Figure 9: Figure VINYL-2: The three possible steps for bond i+1 when there asymmetric center at the
beginning of bond i and that group is in the “d” configuration.
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Figure 10: Figure VINYL-3: The three possible steps on a tetrahedral lattice for a vinyl polymer. The
dark line is bond i+1 and the hatched bond is bond i-1. The circled “R” is the substituent at the
beginning of bond i.
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Figure 11: Figure VINYL-4: The lowest energy configuration for a two-bond substituent (“-R-R”)
attached to an asymmetric center between two trans bonds.
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Figure 12: Figure VINYL-5: A sample pentane effect interaction between two substituent groups in a
vinyl polymer.
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Chapter 5

Copolymers

5.1. Copolymers

      Copolymers are polymers that contain more than one type of monomeric group. Lattice is
capable of qualitative simulations of linear copolymers. Three types of linear copolymers —
random copolymers, alternating copolymers, and block copolymers — are shown in Figure
COPOLYMER-1. For the random and block copolymers, there are four types of bonds — A-A
bonds, B-B bonds, A-B bonds, and B-A bonds. Each of these four bonds could be expected to have
different energies for the trans, gauche+, and gauche- states. The interaction energies depend on the
steric interactions between the groups attached to either end of the bond. We therefore may need to
consider all 16 four-group sequences. By symmetry, we could restrict attention to only the
following 10 four-group sequences: A-A-A-A, A-A-A-B, B-A-A-B, A-B-B-A, A-B-B-B, B-B-B-B,
A-A-B-A, A-A-B-B, B-A-B-B, and B-A-B-A. To incorporate the pentane effect we need to consider
all possible five-group sequences.
      The number of interaction energies required to account for all possible copolymer interactions
are too numerous to be practical and some simplification is required. In Lattice, copolymers are
modeled as having two distinct sets of interaction energies. We therefore have EAg, EAg+/g-, EBg,
and EBg+/g-, where the Eg’s and the Eg+/g-’s are the three-bond gauche interaction energies and
the four-bond pentane-effect interaction energies, respectively. The first letter (A or B) refers to the
copolymer group in which that interaction energy applies. Although many of the possible
interactions present in copolymers are ignored in this simplified scheme, it should be possible to get
qualitative information about chain conformations in copolymers. The capability of using two
distinct sets of interaction energies also allows some quantitative simulations of specific polymers
which could not be handled with only one set of interaction energies.
      Once we have specified the interaction energies, the relative probabilities of a trans, gauche+ or
gauche- step can be found using the analysis discussed in the Generating a Polymer Chain. To
determine which set of interaction energies to use, we must decide whether the next bond should be
an A-group bond or a B-group bond. To make this decision, we define two new parameters — the
A-group replication frequency (RA) and the B-group replication frequency (RB). These replication
frequencies give the probability that the next bond can be identified with the same group as the
previous bond.
      The replication frequencies are a function of the relative rate constants for A reacting with B vs.
A or B reacting with itself. Let kAA, kAB, kBA, and kBB be the rate constants for a bimolecular
reactions between A and A, A and B, B and A (often the same as A and B), and B and B
respectively. Then the A-group replication frequency is

                  RA = kAA [A] / ( kAA [A] + kAB [B] )
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where [A] and [B] are concentrations of monomer. This equation is usually rewritten as

                  RA = r1 [A] / ( r1 [A] + [B] )

where r1 = kAA/kAB is the reactivity ratio for monomer A copolymerized with monomer B.
Similarly,

                  RB = r2 [B] / ( [A] + r2 [B] )

where r2 = kBB/kBA is the reactivity ratio for monomer B copolymerized with monomer B. Notice
that the replication frequencies depend both a rate constants (or reactivity ratios) and the current
concentration ratio of [A] and [B] monomers. In Lattice, you simply enter RA and RB and they are
assumed to be constant during polymerization. In many real copolymerizations, [A] and [B] will
change during the polymerization and thus RA and RB will change. In Lattice, it assumed that [A]
and [B] remain constant either because their decrease due to polymerization is negligible or because
the polymerization process provides constant feed concentrations of the two monomers.
      The values of RA and RB must be greater than or equal to zero and less than one. The specific
values of RA, and RB determine the character and composition of the copolymer being simulated.
First, we consider the composition of the copolymer in terms of the fraction of the groups that will
be A groups. From the copolymer equation (Flory (1955), see References) or from a probability
analysis, the fraction of A groups,  FA, in terms of RA and RB is

            FA = (1 - RB) / (2 - RA - RB)

      Next, we consider the character of the copolymer. If RA and RB are both zero, the copolymer
will be an alternating copolymer and FA will be 1/2. If both RA and RB are nonzero, the copolymer
will be a random copolymer. The larger RA or RB, the longer will be the statistical length of all A or
all B sequences. In fact as RA or RB approach one there will be long blocks of A or B groups and
the copolymer will have the character of a block copolymer.
      With a simple statistical analysis we can calculate the average length of the group sequences as
a function of that group's replication frequency. Consider sequences of A groups. Once an A
sequence begins, the probability that that sequence will have one and only one A group will be (1-
RA). The probability that that sequence will have exactly two groups will be RA(1-RA). This
expression comes from A replicating itself once and then terminating be conversion to a B-group.
We can generalize this result and get the probability that the sequence of A groups has exactly “x”
A groups, P(x). The result is

            P(x) = RA^(x-1) (1 - RA)

We can use this result to calculate the average length of the A-group sequences, LA, as

            LA = 1 / (1-RA)
 
      By adjusting RA and RB, Lattice can be asked to simulate a copolymer with composition FA
having average A- and B-group sequences with lengths LA and LB. How to set the replication
frequencies and the extra interaction energies for copolymers, and how to use Lattice to do a
simulation after those parameters have been set will be described latter, are described in Setting
Simulation Parameters and in Starting Lattice.
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Figure 13: Figure COPOLYMER-1: Three types of linear copolymers — random copolymers, alternating
copolymers, and block copolymer.
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Chapter 6

Monte Carlo Sampling Methods

6.1. Monte Carlo Sampling Methods

      The methods described elsewhere for Generating a Polymer Chain, for generating Vinyl
Polymers, and for generating Copolymers generate realistic chains. Unfortunately, the method does
not precisely sample the set of all possible chains with a probability exactly equal to the Boltzmann
energy factor for the chains being generated. The situation gets even worse when calculations
include Excluded Volume effects or Restricted Chain Space effects. Because of this problem, a
simple average of the end-to-end distance, radius of gyration, etc., of the generate chains will not
give the correct results for the real polymer. Fortunately, there are two solutions, based on weighted
averages, that do lead to the correct results.

Rosenbluth and Rosenbluth Sampling

      Consider a polymer chain on a tetrahedral lattice having n bonds. When this chain is generated
in Lattice, each step may go to one of three configurations for trans, gauche+, or gauche- bonds.
Furthermore, each step of each bond will have some energy (depending on the current polymer
being simulated and whether or not Excluded Volume or Restricted Chain Space on turned on). We
let 

            Et(i) = Energy for bond i being trans
            Eg+(i) = Energy for bond i being gauche+
            Eg-(i) = Energy for bond i being gauche-

From these energies, we define Boltzmann weighting factors, Z, of the form

            Z = exp(-E/RT)

where E is some energy, R is the gas constant, and T and temperature. The Boltzmann factors for
trans, gauche+, or gauche- bonds are denoted as

            Zt(i) = Boltzmann weighting factor for bond i being trans
            Zg+(i) = Boltzmann weighting factor for bond i being gauche+
            Zg-(i) = Boltzmann weighting factor for bond i being gauche-

We then define a total weighting factor (also called “Partition Function”) for bond i as the sum of
the thee bond state weighting factors:
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            Z(i) = Zt(i) + Zg+(i) + Zg-(i)

Finally, we define the Rosenbluth weight for a particular chain (call it chain j) to be

            Rj = P Z(i)            (product over i = 1 to n)

Remember the P symbol means the product of the weighting factors for all bonds.
      In Monte Carlo calculations using Rosenbluth sampling, the average value of any quantity is
found by weighting the result from each chain by its Rosenbluth weight. For example, let rj be the
end-to-end distance for chain j, the correct average end-to-end distance for all generated chains is
found from the weighted average

            <r> = S Rj rj / S Rj

You can read more details about Rosenbluth sampling in the book chapter by Sokal or the original
paper by Rosenbluth and Rosenbluth (see References).

Rosenbluth Sampling In Lattice

      Lattice uses Rosenbluth sampling for all calculations. The use of Rosenbluth weights for long
chains, however, requires great care. If the weighting factors Zt(i), Zg+(i), and Zg-(i) are chosen too
large, the Rosenbluth weights (which are a product of bond factors) will quickly exceed overflow
the floating point limit for computer calculations; if they are too small, they will underflow the
floating point limit for computer calculations. To avoid this problem, Lattice introduces scaling
arguments that keep the Rosenbluth weights from overflowing (or underflowing) even for very long
chains.
      Although Lattice can complete long-chain calculations, Rosenbluth Sampling becomes very
inefficient for long chains, and especially inefficient when Excluded Volume effects or Restricted
Chain Space effects are included. As the number of bonds in the chains increases, the variance in
chain Rosenbluth weights gets large. For long chains, you get the situation where most chains have
effectively zero Rosenbluth weights and once in a great while you find a chain with a large
Rosenbluth weight. The net effect is that Monte Carlo calculations spend most of their time
generating meaningless chains (with low weight) and only rarely generate good chains (high
weight). If you try calculations for long chains, you will notice the the results never converge or
converge very slowly.
      The long chain limit depends on the chain parameters. For most practical polymer properties, it
is difficult to do simulations and get good converged results for polymer chains with more than 500
bonds.

Rosenbluth Sampling for Vinyl Polymers

      Rosenbluth sampling works correctly for Vinyl Polymers, but, if such polymers are analyzed
bond by bond, the convergence of the Monte Carlo simulations is extremely slow. The analysis of
Vinyl Polymers can be dramatically improved by consider two bonds at a time. The bond pairs
considered are bond pairs between assymmetric carbon centers. When bonds are considered two at
a time, the Rosenbluth weights become more uniform and the calculations converge much faster. All
Vinyl Polymers simulations in Lattice are done by this bond-pair method.
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Configurational Bias

      The standard Rosenbluth sampling approach generates a series of independent chains and
calculates a weighted average. The configuration bias method is an attempt to improve efficiency of
the Monte Carlo calculations. It also has uses in other type on Monte Carlo calculations not done
by Lattice. The following describes the configurational bias algorithm. The algorithm starts after
generating the first chain:

1. Instead of discarding the generated chain and starting over, select one end of the chain at random
and then select some number of bonds between 1 and n (where n is the total number of bonds). The
first step is to unzip the randomly selected bonds but remember the Rosenbluth weight for that sub-
chain of bonds. Call that initial weight Ri.

2. The second step is to generate new bonds and calculate the Rosenbluth weight for the new sub-
chain of bonds. Call the new weight Rf.

3. If Rf is greater than Ri then accept the new chain, but if Rf is less than Ri, define a probability
factor p= Rf/Ri. For this latter case, generate a random number x between 0 and 1 and accept the
new chain if x<p but reject it if x>p.

4. If the new chain is accepted, use it in the Monte Carlo evaluation of average properties. If the new
chain is rejected, use the previous chain again in the Monte Carlo evaluation of average properties.

      In effect, the configurational bias methods attempts to reuse parts of chains by letting the
configuration of the chain evolve with time. The algorithm above insures that the chain
conformations evolves through conformations that representative of real polymer conformations.
Step #3 for conditional acceptance of chains with lower weights is called the Metropolis method
(see References and note: “Metropolis” is the name of a scientist and not Superman’s home
town). It is the key step to insuring the configurational bias method gives valid results. You can read
more details about configurational bias methods in Frenkel and Smit (see References).

Chemical Potential Calculations

      Whenever some bond steps might be inhibited by Excluded Volume or Restricted Chain Space
effects, that chain can be said to have a higher chemical potential energy that the corresponding
chain with no restrictions. You can read the help top on Chemical Potential to learn how chemical
potential energy difference is calculated and displayed by Lattice.

6.1.1. Chemical Potential

      Whenever you do a simulation with Excluded Volume or Restricted Chain Space effects,
Lattice will calculate the chemical potential energy difference between the chains you generate and
the corresponding chain that has no Excluded Volume or Restricted Chain Space limitations. The
formula for change in chemical potential, from statistical thermodynamics, is

                  ∂µ = RT (ln (<Z>) - ln (<Z0>))

where R is the gas constant, T is absolute temperature, <Z> is the average Rosenbluth weighting
factor for all chains generated, and <Z0> is the average Rosenbluth weighting factor for the same
chains if they had been generated with no restrictions on each bond jump. The Rosenbluth factors
are explained in Monte Carlo Sampling Methods.
      In effect, the Rosenbluth weights provide a measure of the thermodynamic partition function for
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the ensemble of chains being generated. From statistical thermodynamics, RT ln Z, where Z is a
partition function, is free energy for an ensemble. Here we can only calculate a change in energy,
thus subtracting

                  RT ln <Z0> 

means we are calculating the excess free energy (or chemical potential) for the chains caused by the
Excluded Volume or Restricted Chain Space effects. In other words, ∂µ provides a thermodynamic
measure of the impact of  Excluded Volume or Restricted Chain Space effects on the chain
conformations. This number will be close to zero if the chain properties and chain space are such
that the chain only rarely intersects itself or only rarely contacts a barrier. The change in energy will
increase as chain intersections or contacts with barriers become more frequent.

Energy per Bond

      The chemical potential energy difference displayed in the Simulation Results Window is given
in Joules per mole of polymer molecules. When comparing chains with different numbers of
bonds, it is sometimes better to look at the chemical potential energy per bond. The “per bond”
result is simply the calculated ∂µ divided by the number of bonds in the chain.

Entropy Effects

      Finally, there are no specific interactions between non-neighboring parts of chains as simulated
in Lattice. Physically, this type of simulation implies there are no enthalpy effects. In other words,
if we write ∂µ in terms of ∂H and ∂S, where H and S are enthalpy and entropy, we have

                  ∂µ = ∂H - T ∂S = -T ∂S

where the second result uses ∂H = 0 (no enthalpy effects). It is thus reasonable to also calculate the
effect of Excluded Volume or Restricted Chain Space on the configurational entropy of the chains.
The change in entropy is given by

                  ∂S = -(∂µ / T) = -R (ln (<Z>) - ln(<Z0>))

This ∂S can easily be calculated from Lattice results for ∂µ.
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Chapter 7

Running Lattice

7.1. Starting Lattice

      The application Lattice requires of Power Mac running System 8.1 or newer. System 8.6 or
newer is recommended and MacOS X is ideal. If you are using MacOS 9.x or older, you have to
have the CarbonLib extension; this extension is standard in most of theses systems. You can start
Lattice by double-clicking on any the applicaiton icon or any document icon.

Brief Overview of Running Simulations

      Once you have started Lattice, you will want to run some simulations. The following steps are
common to most simulations:

• To do a simulation of any polymer you first set the polymer parameters using the commands in
the Options Menu (see Setting Simulation Parameters). Using the Polymer Chain... command
in the Options Menu you set the number of chains you want to generate in the simulation.

• Next, you do the simulation by selecting the Start command in the Control Menu. Lattice will
run the simulation and the results of the simulation will be displayed in the Simulation Results
Window. You can interrupt a long simulation at any time by selecting the Stop command in the
Control Menu or by typing ⌘..
• Plots of individual polymers or of the distribution of end-to-end distances will appear in the Plot
Window (see Plotting Simulation Results).

• When a simulation is done you can save the simulation results in a file using the Save or Save
As... commands in the File Menu. A saved simulation can be opened at a later date and continued
by generating more chains. A saved simulation can also be added to Lattice Experiments.

• The calculation results can be copied and pasted into any other application that accepts pasted text
or graphics (see Edit Menu - copying simulation results).

• When you are running many simulations, it is best to set use an “Experiment” file. For more
information see Lattice Experiments and Experiment Menu.
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• For technical questions, you can contact the Developer
     

7.2. Setting Simulation Parameters

      The simulation parameters are set by using the first seven commands in the Options Menu.
Each command will bring up a dialog box for entering some of the possible parameters. The
operation of each command is described below:

Polymer Chain…
      This command is used to set the number of bonds in the polymer chain, the length of the bonds
in the polymer chain, and the number of chains to be generated in the Monte Carlo simulation. After
a simulation is started, the simulation will continue until the number of chains generated is equal to
the number of chains requested using this dialog box. Note that if the number of chains requested
is set to less than or equal to the number of chains that have already been generated, any attempts at
continuing the simulation will immediately abort. To continue such a simulation, change the number
of requested chains to a larger number.
      In Monte Carlo simulations, one important question is how many chains have to be generated to
result in meaningful results. The answer depends on your simulation parameters. In brief, 500
chains should be considered a minimum. To get good results on the distribution of end-to-end
distances you may need to generate 1000 to 2000 or more chains.

Weighting Factors…
      This command is used to set the weighting factors or rather the energies for the gauche+ or
gauche- states and for the gauche+/gauche- state relative to the corresponding trans state being at
zero energy. In the nomenclature of the Generating a Polymer Chain information, this command is
used to set Eg (the 3-bond interaction energy in gauche+ or gauche- bonds) and Eg+/g- (the 4-
bond interaction energy due to the pentane effect in gauche+/gauche- bond pairs). The energy
values are entered in Joules and they need not be positive. For some polymer chains, the gauche+
or gauche- state is lower in energy than the trans state. For these polymers, Eg should be set to a
negative number.

Vinyl Polymers…
      This command is used to set the extra parameters required for simulation of Vinyl Polymers.
First, to initiate a simulation of a vinyl polymer, check the vinyl polymer check box. Second, set the
stereochemistry replication frequency. If the replication frequency is set to one then each chain will
have only one stereochemical configuration and therefore the polymers will be isotactic. If the
replication frequency is set to zero, the stereochemical configurations will alternate between “ d ”
and “l” centers. The polymers will therefore by syndiotactic. All other replication frequencies will
result in a random arrangement of stereochemical configurations or atactic polymers. Lastly, you
need to set all the required weighting factors described in the information on  Vinyl Polymers. The
required weighting factors are:

      Eg: standard 3-bond gauche interaction between parts of the main polymer chain  
      Eg+/g-: pentane effect interaction
      E-R/g: gauche-like interaction between “-R” and the polymer chain in gauche 
                        bonds
      E-R/t: gauche-like interaction between “-R” and the polymer chain in trans bonds
      E-R-R/tt: gauche-like interaction between the groups two bonds away from the 
                        main polymer chain and trans/trans bond pairs
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The first two are set using the Weighting Factors… command (see above) and the latter
three are set in the vinyl polymers dialog box. All weighting factors should be entered in Joules.

Copolymers…
      This command is used to set the extra parameters required for simulation of Copolymers. First,
to initiate a simulation of a copolymer, check the copolymer check box. Second, set the A- and B-
group replication frequencies. If the two replication frequencies are both zero, the copolymer will be
an alternating copolymer. For non-zero replication frequencies, the copolymer will be a random
copolymer. As the replication frequencies approach one, the copolymer will resemble a block
copolymer. As described in the chapter on copolymers, the average length of the blocks is a simple
function of the replication frequency. Lastly, you need to set the weighting factors for the A-group
and for the B-group bonds. The weighting factors in the Copolymer dialog box are used to set

      EBg: the 3-bond interaction energy in gauche+ or gauche- bonds
      EBg+/g-: the 4-bond interaction energy due to the pentane effect in 
                        gauche+/gauche- bond pairs

which are the weighting factors for the B-group bonds. The weighting factors for the A-group
bonds are set using the Weighting Factors… command (see above). All weighting should be
entered in joules.
      The bond length in the copolymer bonds is set using the Polymer Chain… command (see
above). This bond length applies to both A-group and to B-group bonds. In other words you can
not have different bond lengths in the two types of copolymer bonds. This limitation is imposed by
the confinement of the polymer chain to the tetrahedral lattice. The tetrahedral lattice in a single
simulation is limited to a single bond length.

Temperature…
      This command is used to set the temperature. As discussed in previous chapters, the
probabilities of the various bond conformations are determined by Boltzmann factors such as exp(-
Eg/RT) and exp(Eg+/g-/RT). The temperature to be used in these Boltzmann factors is the one you
enter using this command. The temperature should be entered in degrees Kelvin.
 
Excluded Volume…
      This command is used to set whether the random walk that is generated will be allowed to cross
itself or whether the random walk will be a self-avoiding random walk. In other words, this
command allows you to set whether or not the simulation will check for Excluded Volume effects.
To include Excluded Volume effects select either “Include Excluded Volume (Rosenbluth
Sampling)” or  “Include Excluded Volume (Configuration Bias)”. The meanings of “Rosenbluth
Sampling” and “Configurational Bias” are given in Monte Carlo Sampling Methods.
      
Restricted Chain Space…
      This command is used to restrict the space available to the polymer chain. You restrict the chain
space by specifying planes that act as walls to limit the random walk. For more information see the
help topic on Restricted Chain Space.

7.2.1. Simulation Results Window

      The results of the Monte Carlo simulation appear in the Simulation Results Window which
contains a table of results and initially appears near the top of your computer monitor.
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Simulation Results Window Header

     The top few lines of the window list the parameters of the polymer being used for the current
simulation. The actual parameters listed will depend on the type of simulation being done. Typical
parameters listed for homopolymers, vinyl polymers, and copolymers are

      Bond L:1.53   Bonds:20   Ex Vol:No   Homopolymer
   Energies:   g:2100   g+/g-:8400
   Limits:none                          Temp:300        Chains:1

   Bond L:1.53   Bonds:20   Ex Vol:No   Vinyl Polymer:R=0.500
   g:2100   g+/g-:8400  -R/g:4200   -R/t:2100   -R-R/tt:0
   Limits:none                          Temp:300        Chains:1

   Bond L:1.53   Bonds:20   Ex Vol:No   Copoly(50%A):RA=0.5,RB=0.5
   Energies:   g:2100   g+/g-:8400  Bg:2100  Bg+/g-:8400
   Limits:none                          Temp:300        Chains:1

The first line of parameters gives the bond length in Å (“Bond L”), the number of bonds in the
polymer (“Bonds”), whether or not the simulation will check for excluded volume (“Ex Vol”),
and a description of the type of polymer. For Vinyl Polymers the description includes the
stereochemistry replication frequency. For Copolymers the description include the composition (as
percent of A groups) and the A- and B-group replication frequencies. The second line lists all the
energies required for assigning the relative probabilities at each step. The energies are given in
Joules. The last line list any Restricted Chain Space (“Limits”), the temperature in degrees Kelvin
(“Temp”), and the number of chains to be generated in the next simulation (“Chains”).
      Each of the listed parameters are set using the commands in the Options Menu (see Setting
Simulation Parameters.

S imulation Results Window Table

      Below the list of parameters in the simulation results window will be a table of the current
simulations results. This table is updated with the most recent results after each chain is generated.
Definitions of each item in the simulation results table follow:

1. chains
      The number of chains that have been generated in the current Monte Carlo simulation. In
general, the more chains generated, the more accurate will be your simulation results. Experience
suggests that about 500 chains will give reasonably accurate results in most situations. Lattice can
plot the distribution of end-to-end distances as a bar chart (see Plotting Simulation Results). For
this plot to be accurate you will need to get many chains within each bar and this task typically
requires significantly more than 500 chains. Experience here suggests that 1000-2000 or more
chains will be required for good distribution plots.

2. Last r
      The end-to-end distance in Å of the most recently generated chain.

3. rms r
      The root-mean-squared end-to-end distance in Å of all the chains that have been generated in
the current simulation.

4. <r>
      The average end-to-end distance in Å of all the chains the have been generated in the current
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simulation. Note that the standard deviation in end-to-end distance for the current simulation is
given by:

                  Std Dev in r = ( (rms r)^2 - <r>^2)^(1/2)

5. rms s
      The root-mean-squared radius of gyration in Å of all the chains that have been generated in the
current simulation.

6. r^2/nl^2
      The characteristic ratio. Here n is the number of bonds and l is the bond length.

7. r^2/s^2
      The ratio of the mean-squared end-to-end distance to the mean-squared radius of gyration. For
large, random-coil polymers, this result should be close to 6.

8. % trans
      The percentage of all the bonds in the current simulation that have been in the trans state.

10. ∂µ (J)
      When doing Excluded Volume or Restricted Chain Space calculations, this last column will give
the Chemical Potential energy difference between the chains generated and the corresponding
unrestricted chains. The number is in Joules per mole of chains.

7.2.2. Excluded Volume

      The previous discussions on generating polymer chains have described non-interacting random
walks (see Generating a Polymer Chain, Vinyl Polymers, and Copolymers). In non-interacting
random walks, it is possible for the polymer chains to revisit lattice sites. A better simulation for real
polymer chains would be to use self-avoiding random walks which disallow the revisitation of
lattice sites. This type of random walk simulates the excluded volume effect whereby each atom in a
polymer chain excludes its occupied volume from being occupied by any other part of the polymer
chain. Lattice can do either non-interacting random walks or self-avoiding random walks.
      In random walks on a tetrahedral lattice, each step can jump to one of three possible sites. When
Lattice is checking for excluded volume or generating self-avoiding random walks, it first checks
each of the three possible jumps to see if any step causes a chain intersection. If any of the three
steps is to an already-occupied site, that jump direction is assigned an infinite energy or a zero
probability when selecting the next jump direction.

Sampling Methods

      When you include excluded volume effects, you can choose to have the Monte Carlo
calculations done by Rosenbluth Sampling or by a Configurational Bias algorithm. Some details on
these sampling techniques for Monte Carlo calculations are explained in Monte Carlo Sampling
Methods. In brief, Rosenbluth sampling is the standard method in which a series of chains are
generated and the average properties are calculated by a weighted average of the results using
“Rosenbluth” weights for each chain. This weighted average has been show to give the correct
ensemble average of the results.
      The Configuration Bias is an attempt to construct a more efficient algorithm. Instead of
generating a series of independent chains, the Configuration Bias method tries to reuse part of the
previous chain. In brief, it undoes some random number of bonds at a randomly selected end of the
polymer, regenerates new bonds, and finally accepts or rejects the new chain based on a the relative
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“Rosenbluth” weights of the new chain and the previous chain. More details are given in Monte
Carlo Sampling Methods.

Effective Energy of Excluded Volume Interactions

      Because excluded volume effects may cause certain states to be assigned infinite energies, it
effectively changes the Chemical Potential energy of the chains relative to the corresponding
unrestricted chains. Whenever you do an excluded volume calculations, the “∂µ (J)” column in
the Simulation Results Window will give the effective increase in energy caused by forcing the
chains to avoid interactions with themselves.

Miscel laneous

      For information on how Lattice uses computer memory to do the fastest possible excluded
volume simulations, see the help topic on the Site Occupation Table.
      Another form of excluded volume is Restricted Chain Space. If a polymer is near a barrier such
as between two adherends in an adhesive bonds than the random walk steps must be prevented from
crossing that barrier. Lattice can impose constraints on the polymer chain space be imposing
impenetrable barriers to the random walk. For more information see Restricted Chain Space.

7.2.3. Site Occupation Table

      When Lattice generates self-avoiding random walks to simulate the Excluded Volume effect, it
must verify that each step in the random walk proceeds to a vacant lattice site. To make this type of
simulation efficient, Lattice creates and maintains a site occupation table. Each lattice site is
assigned a single bit in memory. If that bit is set, that lattice site is occupied; if that bit is clear, that
site is vacant.
      Each polymer starts at the origin and moves at most one lattice site in any direction on each
bond jump. The current version of Lattice allows a user-defined maximum number of bonds. Most
users will select a maximum number of bonds of at least 1000. For chains this long, it is possible
that lattice sites ±1000 lattice sites in any direction may eventually become occupied. A table of all
these lattice sites would require (2(1000)+1)3 = 8,012,006,001 bits or about 1 gigabyte of memory.
Clearly no Macintosh has this much memory and therefore Lattice must make do with a less than a
complete site occupation table.
      When Lattice starts, it grabs most of the memory allocated by the system to create the largest
possible site occupation table. The size of the resulting site occupation table that was created will be
printed in the dialog box that is invoked by the Excluded Volume… command in the Options
Menu. The size of the table is expressed as the number of lattice sites in any direction from the
origin that are included in the table.
      To maximize the size of the site occupation table, you should allocate as much memory as
possible to Lattice (this allocation only works in MacOS 9.x or earlier; In MacOS X, the
application will always have plenty of memeory). The amount of memory allocated to Lattice can
be adjusted by choosing the Get Info… command in the Finder menus while the Lattice icon is
selected. The more memory you allocate for Lattice, the larger will be the site occupation table. Of
course you are always limited by the amount of memory available in your computer.

Use of the Site Occupation Table

      As long as your chains remain within the site-occupation table (i.e., sufficiently close to the
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origin), simulations that check for Excluded Volume can use the site occupation table and they will
be very fast. If some bonds extend beyond the site occupation table, those lattice sites have to be
saved in a separate table and each subsequent bond has to be compared to each site in that table. If
many bonds extend beyond the site occupation table, this extra checking will slow down the
simulation.
      Thus, for the fastest Excluded Volume simulations, you should allocate as much memory as
possible to Lattice (see above) to create the largest possible site occupation table. Fortunately, for
most random coil polymers, the size of the site occupation table can be significantly less than the
number of bonds and still have the situation that bonds extending beyond the site occupation table
is a rare event. Assuming the site occupation table should be larger than the radius of gyration, you
would like the site occupation table to include at least

                  ( C n / 6) ^(1/2)

lattice sites in each direction where C is the characteristic ratio for the polymer being simulated.

7.2.4. Restricted Chain Space

      An interesting feature of Lattice is that you can erect barriers to the random walk and study
how those barriers affect the end-to-end distance, or how those barriers affect the Chemical
Potential energy of the chains. For example, you can study polymers confined to boxes of various
dimensions or polymers bound to a planar surface. This help topic explains how to set up a
restricted chain space calculations.

Setting up a Restricted Chain Space

      The Restricted Chain Space… command in the Options Menu is used to restrict the
space available to the polymer chain. You restrict the chain space by specifying planes that act as
walls to limit the random walk. These planes are specified by setting limits on travel in each of the
three directions — the x-axis direction, the y-axis direction, and the z-axis direction. The limits of
travel are specified in units of bond lengths. For polyethylene chains with the bond length equal to
1.53 Å, specifying an x-axis minimum of -2 would prevent the chain from traveling more than 3.06
Å in the negative x-axis direction. In effect you have placed a plane at x=-3.06 Å that is parallel to
the plane defined by the y and z axes. The polymer will not be allowed to cross this restricting
plane. In a similar way, travel in the positive x direction, or travel in the positive or negative y or z
directions can be limited be specifying the limit in the dialog box. If no limit is specified for any
given direction, than travel in that direction is unrestricted.
      All generated polymers start at the origin which means that the x, y, or z axis minimums must be
less than or equal to zero and the x, y, and z axis maximums must be greater than or equal to zero.
If you set illegal restrictions, you will be notified and asked to change them.
      If the minimum and maximum extent along any axis encloses less than two lattice sites, no
polymer will be able to fit on the lattice while still being within the restricted chain space. If you
attempt to set such restrictive limits, you will be informed of the invalid limits and asked to change
them.

Restricted Chain Space Simulations

      Restricted random walks are handled in a manner similar to Excluded Volume effects. Before
each step, the three possible steps for the next bond are checked. If any of them are beyond a
barrier, that step is assigned and infinite energy or a zero probability when selecting the next jump



Running Lattice

Page 32

direction.
      Random walks in restricted space may reach dead ends. If all of the three possible jumps from a
particular lattice site (See Figure GENERATING-1) carry the random walk beyond a restricting
plane, then no jump is acceptable and the chain has to be discarded and a new chain started. The
probability of reaching a dead end is strongly dependent on the amount of restriction placed on the
random walk space and on the number of bonds in the chain. If 20 chains in a row reach a dead
end, you will be notified that your chain space is probably too restricting to result in many complete
chains. You will then have the option of stopping the simulation or of continuing to try squeezing
random chains into the limited space. If you want to attempt a simulation that issues many dead-end
warnings without having to respond to each warning, you can use the Preferences… command to
disable the dead-end warnings.

Sampling Method

      When you do restricted chain space calculations, you have a choice of three Monte Carlo
sampling methods — “Rosenbluth Sampling,”, “Configurational Bias (Free ends),” and
“Configurational Bias (Fixed Starting Point).” Rosenbluth sampling is the most common method.
In this sampling method a series of independent chains are generated and the results are average
according to their “Rosenbluth” weights. For more information see Monte Carlo Sampling
Methods.
      In contrast, the configurational bias methods generates one chain and then lets the conformation
evolve by changing the configuration of some random number of bonds. In brief, instead of
regenerating an entire new chain, one end of the chain is selected at random and some random
number of bonds are unzipped and regenerated. The configurational bias algorithm (described in
Monte Carlo Sampling Methods) accepts or rejects the new conformation for calculation of average
properties. Configurational bias methods can potentially help restricted chain space calculations
with tight spaces because it avoids having to start over finally find a chain that fits into the restricted
space.
      There are two configurational bias methods for restricted chain space calculations. The “Free
Ends” method is the standard algorithm. It lets the conformation evolve at both ends of the chain.
In contrast, the “Fixed Starting Point” method keeps the starting point fixed at the origin and only
lets the other end evolve. The “Fixed Starting Point” method is needed, for example, if you want to
simulate a chain bound to a surface. To due such a simulation you define one of the limits to pass
through the origin (e.g. x (negative) = 0) and select either “Rosenbluth Sampling,” or
“Configurational Bias (Fixed Starting Point).” Each of this methods will guarantee that one end of
the chain (the starting point) is touching the surface at x=0. If you select “Configurational Bias
(Free ends)” the chain will evolve from both ends and may evolve away from the surface.

Effective Energy of Restricted Chain Space Interactions

      Because restricted chain space effects may cause certain states to be assigned infinite energies, it
effectively changes the Chemical Potential energy of the chains relative to the corresponding
unrestricted chains. Whenever you do restricted chain space calculations, the “∂µ (J)” column in
the Simulation Results Window will give the effective increase in energy caused by forcing the
chains to avoid barriers.

Polymer Plots

      When polymers in restricted chain spaces are plotted (see Plotting Simulation Results) you
have the option of showing or not showing the restricting planes and of showing or not showing the
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standard box that just encloses the polymer.
      There are two check boxes in the restricted chain space dialog box. One check box requests a
plot of a box around the polymer in plots of the polymer chains. The other check box requests plots
of the restricting planes along with the plots of the polymer chain. An unchecked box disables that
plotting feature. You can check either box, both boxes, or neither.

Excluded Volume

      Checking for Excluded Volume and using a restricted chain space are independent features of
Lattice. You can limit the chain space and generate chains that ignore excluded volume or generate
chains that check for excluded volume interactions.

7.3. Plotting Simulation Results

      Lattice has several plotting options and all plots will appear in the Plot Window. First, you can
plot the results during a simulation. You can plot various three-dimensional views of the most
recently generated polymer, or you can plot the distribution of end-to-end distances.
      Second, you can plot the results of Lattice Experiments. To plot the results of an experiment use
the Experiment Report... menu command in the Experiment Menu. An experiment plot will
replace any current plot and disable future polymer chain or end-to-end distribution plots until they
are turned on again using the methods described below.
      The two types of plots available during a simulation are selected by using two commands in the
Options Menu; the two commands are described below:

Plot Polymers…
     When this menu item is checked, each chain that is generated will be plotted in a three-
dimensional plot. Lattice will also plot a box that encloses the polymer chain. The back surface of
the polymer box will be shaded light gray to help orient the box.
      Lattice can do three types of 3D plots. The default plot type is a full plot showing all main-
chain and side group bonds and drawing spheres at each lattice site to represent the atoms or
molecular groups located there. If you only want to see the bonds, you can turn off the atom
spheres and get plots of just the bonds connecting lattice sites. For bond plots you can have just
main chain bonds or show main chain as well as side chain bonds. Click the following to see some
sample plots:

      Full plot with all bonds and atoms in Figure PLOT-1 (in color)
      Plot of main chain and side-chain bonds in Figure PLOT-2 (in color)
      Plot of only main chain bonds in Figure PLOT-3 (in color)

All plots use color and you can customize all colors as explained below (or see Color Plots.) The
color setting options also let you set the radius of spheres that are drawn for atoms at lattice sites.
Finally, you can turn off all colors in case you want to print on a black and white printer. A sample
black and white plot is shown in Figure PLOT-4.
      To select the style of 3D plotting and/or to begin polymer plotting when this menu item is not
checked, you choose the Plot Polymers… menu command. You will get a dialog box where
you can can select the plotting style you want or turn off polymer plotting. If a style is selected, the
current polymer will redraw in the new style and the menu item will be checked. If you select “No
Polymer Plots”, the plot window will be closed and no further polymer plotting will occur until a
plotting option is changed.
      When you create chains in a Restricted Chain Space, you have two additional plotting options.
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The first option is to plot or not to plot the box enclosing the polymer that was described above.
The second option is whether or not to show the planes that restrict the chain space. You can
activate both plot options, either plot option, or neither plot option. These two plot options only take
effect when the chain space is restricted in at least one direction. When no restrictions are placed on
the chain space, all polymers will be plotted with an enclosing box.
     Finally, note that each plot is scaled to use as much of the plot area as possible. The plot will
always include the entire polymer chain, the box enclosing the polymer (if requested) and the planes
restricting the chain space (if requested).

Plot Distribution
      When this menu item is checked, a plot of the distribution of end-to-end distances will be
plotted after each polymer chain is generated. the distribution of end-to-end distances will be plotted
as a bar chart. Superimposed on the bar chart will be a solid line which will be a plot of the radial
Gaussian distribution corresponding to the current simulation results. As discussed in Flory (1969)
(see References), a radial Gaussian distribution for the end-to-end distance of 3-dimensional
random walks has the form:

            W(r) dr = 4πr^2 (3/(2π<r^2>)^(3/2) exp(-3r^2/(2<r^2>))

where <r^2> is the mean squared end-to-end distance. Sample plots of the distribution of end-to-
end distances are shown in Figure PLOT-5 (in color) and in Figure PLOT-6 (in B&W).
      Lattice picks the width of the bars in the end-to-end distance plot according to a user-defined
histogram density. The histogram density can be changed using the Preferences… command in the
Edit menu. The histogram density is proportional to the number of bars per inch used in the end-
to-end distance plot. Higher histogram densities produce more bars and narrower bars; lower
histogram densities produce fewer bars and wider bars. If you do not like the appearance of your
end-to-end distance plot, use the procedure given in the description of the Preferences… menu
command for setting the histogram density. One confusing aspect of the histogram density setting
is that changing it only effects future simulations and will not change the appearance of end-to-end
distance plots for previously saved simulations. If end-to-end distance plots are important to you,
you should adjust the histogram density before beginning your simulation.

Fit Plot in Window
      When the Plot Window is first created it is sized to fit below the Simulation Results Window
and use the remainder of your monitor. All plots are automatically scaled to use this entire Plot
Window. You can move and resize the plot window, but the plots will still be scaled to fit the initial
Plot Window. If you make the window smaller, you can use the scroll bars to scroll around the plot.
     The Fit Plot in Window command allows you to change the size of the current and all
future plots. Whenever you select this command, the current plot will be redrawn to fit in the current
Plot Window and all future plots will be similarly scaled. In brief, to control the size of your plots
you first resize the Plot Window to the desired size and then choose the Fit Plot in Window
command.

Plot Colors…
      Polymer plots and plots of the distribution of end-to-end distances will appear in color if you
have a color monitor. To learn what the colors mean and how to change the plot colors see Color
Plots. The color customization options also let you customize the size of atoms drawn at lattice sites
in some 3D plots.

Disabling Plotting
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     If both the Plot Polymers… and the Plot Distribution menu commands are
unchecked, then no plots will be generated and no plots will appear after each polymer chain is
generated. Because plotting takes time, this situation will result in the fastest possible simulations.
      To get both plot commands unchecked you can close the Plot Window by clicking its close
box, select the Plot Distribution menu command if it is currently checked, or select the Plot
Polymers… menu command and choose the “No Polymer Plots” option.
      Additionally, whenever you get a plot using the Experiment Report... menu command in
the Experiment Menu, that plot will replace the current plot and both the Plot Polymers… and
the Plot Distribution menu commands will become unchecked. To return to plots of polymer
chains or plots of the distribution of end-to-end distances, simply choose the appropriate command
in the Options Menu.

7.3.1. Plot Window

      All plots appear in a separate plot window. This window is initially placed just below the
Simulation Results Window and is sized to make maximum use of your computer monitor. The
plot window, however, is resizable. If you want to adjust the size of your plots, you merely need to
resize the plot window before doing the plot. All plots are automatically sized to fit within the plot
window.

Save or Save As...
      Whenever the plot window is in front, you can use these commands in the File Menu to save the
current plot into a PICT file. Many Macintosh drawing programs (e.g., SuperPaint) can read PICT
files. You can  thus open the plots with another application and edit the plot graphics.

Fit Plot in Window
      This command in the Options Menu will cause future plots to be scaled to fit within the current
plot window. To control the size of your plots, you thus resize the plot window to the desired size
and choose this command.

Disabling Plotting

      If the current simulation is plotting polymers or plotting the distribution of end-to-end
distances, you can disable that plotting by closing the plot window for continuing with the
simulation.

7.3.2. Color Plots

      All plots in Lattice will make use of color if your computer and monitor have color capabilities.
This topic explains what the colors means, how to change them, and how to disable color plotting.
Some 3D polymer plots can draw spheres at lattice sites to represent atoms or molecular groups in
the polymer. This topic also explains how to customize the size of those spheres.

Plots with Polymer Chain Bonds

      In plots of polymer chains, trans bonds, gauche+ bonds, and gauche- bonds on the main chain
will each plot in different colors. This feature makes it easy to visualize the predominant bond types
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and to recognize sequences of bond types. For a sample, see Figure PLOT-3.
      The default colors are:

            BLUE FOR TRANS BONDS
            RED FOR GAUCHE+ BONDS
            GREEN FOR GAUCHE- BONDS

      In copolymers, the trans bonds, gauche+ bonds, and gauche- bonds for B type monomers will
also plot in different colors and they will plot in colors different than the A type bonds. The A type
bonds default colors are given above. The B type bond default colors are:

            CYAN FOR TRANS BONDS
            MAGENTA FOR GAUCHE+ BONDS
            YELLOW FOR GAUCHE- BONDS

      Some 3D plots will show bonds to side groups as well as the main chain bonds (see Figure
PLOT-2). The default side bond colors are:

            DARK GRAY FOR A-TYPE SIDE BONDS
            LIGHT GRAY FOR B-TYPE SIDE BONDS

Plots with Polymer Atoms

      Some 3D plots will show spheres at each lattice site to represent atoms in the polymer or
possible monomer units or side groups (see Figure PLOT-1). Each possible type of main chain
group or side group can have its own color. The default settings are:

            CARNATION FOR MAIN-CHAIN A GROUPS
            TAN FOR A-TYPE SIDE GROUPS
            TANGERINE FOR MAIN-CHAIN B GROUPS
            MOSS FOR B-TYPE SIDE GROUPS
            PALE VIOLET FOR VINYL SIDE GROUPS

      You can also select the radius for each group type. Radii are entered in Angstroms. For ideal
plots, the sum of any two radii should be less then the lattice site separation or the current bond
length (see Setting Simulation Parameters). Plots with atoms usually look best when radii are large
enough for the spheres to be seen but small enough for main chain and side bonds to be seen
between the spheres. Note that such settings will be smaller then typical estimates of atomic radii
for atoms or groups in the polymer chain.

Boxes Around the Polymer Chain

      The box around the polymer will plot in light gray and the background of the box will be filled
with very light gray.
      If you use a Restricted Chain Space, the restricting planes will plot in light blue.

Plots of the Distribution of End-To-End Distances

      The bars in the plot will be filled in cyan and framed in a darker blue. The plot of the radial
Gaussian distribution function will plot in red. For a sample, see Figure PLOT-3.
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Plots of Experiment Data

      Plots generated using the Experiment Report option will draw each plotted curve in a separate
color. The key will reflect the colors of each curve.

Changing the Default Colors
 
     By using the Plot Colors… command in the Options Menu you can change any of the
default colors or disable color plotting entirely.

1. To change any color click on that color in the Plot Colors… dialog box and select a new
color using the standard Macintosh method for selecting colors.

2. To revert to the default colors click on the Use Defaults button.

3. To disable color plots check the B&W Plots check box. When you select black & white plots
all lines will drawn in black and background shading (for the polymer box and for the bars in plots
of the distribution of end-to-end distances) will use a “grayed” pattern. If you do not have a color
printer, you will find that black & white plots will print better than color plots. Similarly, you should
use black & white plots if you plan to copy the plots and paste them into some other application
that does not support color plots.

Figure 14: Figure PLOT-4: Sample plot of a polymer chain (only a black & white sample plot is shown
because color may not print well).
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Figure 15: Figure PLOT-6: Sample plot of the distribution of end-to-end distances (only a black & white
sample plot is shown because color may not print well).
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Chapter 8

Running Experiments

8.1. Lattice Experiments

      You will normally use Lattice  is to run experiments. In an experiment you do a series of
simulations where all simulation parameters are the same except one. The results of this series of
simulations will be a Lattice experiment exploring the affect of the changing that parameter on the
end-to-end distance, on the radius of gyration, and on the other results in the simulation results
window.
      For example, you might want to see the end-to-end distance as a function of the number of
bonds. To do this experiment you create several simulations with all parameters the same except the
number of bonds parameter. After completing all simulations you can plot  the end-to-end distance
as a function of the number bonds. Additional Lattice experiments might be the plot the
characteristic ratio as a function of the number of bonds, the radius of gyration as a function of the
temperature, the end-to-end distance as a function of the energy of the gauche state, and much,
much more.
      Fortunately, Lattice makes it easy to coordinate experiments. In brief, an experiment is any set
of simulation files. Lattice can create experiment files that link the simulation files into a single
experiment. Once you have created an experiment file it is easy to generate more chains for each
simulation (see Experiment Menu), to plot the results of the experiment (see Experiment Report), to
print the experiment results in a table (see Experiment Report), or to copy the experiment results to
another application for the purpose of preparing a report (see Experiment Report).

Creating A Set of Simulations

      To begin an experiment you create a set of simulations in which all parameters except one are
the same. The changing parameter or the experimental variable can vary from simulation to
simulation. You should save each simulation using the Save or Save As... commands in the
File Menu. All simulations for a single experiment must be in a single folder. Note that you will not
be able to save a simulation until you have generated at least one chain. You can easily generate
exactly one chain by using the One More Chain command in the Control menu.

Creating the Experiment File

      After creating all the simulation files that you intend to be part of your Lattice experiment, you
create the experiment using the New Experiment... command in the Experiment Menu. You
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must save the experiment file in the same folder as one used to save the simulation files. The new
experiment will be started in a blank Experiment Window. You next use the Add... command in
the Experiment Menu to add the simulation files to the new experiment. You select files using the
standard Macintosh procedure for opening files. If you have a recent MacOS, you can select
multiple files for adding by holding down the shift key and clicking on the file names. When you
click “OK”, all selected files will be added to the experiment file. If you have an older MacOS, you
will only be able to select one file at a time but you can keep selecting files in subsequent dialog
boxes until you have selected all the files you want for the new experiment. When you are done
selecting files click the Cancel button. If you add an incorrect simulation file, you can remove it
from the experiment at any time using the Remove command in the Experiment Menu.

Running an Experiment

      The initial purpose of a Lattice experiment is to run the experiment. The manual process of
running an experiment is to open each individual simulation and generate some number of chains.
The experiment will be completed when you generate enough chains for each simulation.
Fortunately Lattice allows you to automate this process by using the Run... command in the
Experiment Menu.
      After selecting the Run... command, you will be asked how many chains to generate and a
simulation will be run for each file in the experiment until its number of chains reaches the
requested number of chains. In other words, Lattice will automatically open each simulation file,
generate the requested number of chains, and then save the results.
      If the experiment is taking too long you can stop it at any time using the Stop command in the
Control Menu or by typing ⌘.. All results completed up to the point of stopping the experiment
will be saved and you can return to the experiment file to finish the experiment at some later date.

Studying the Experimental Results

      Once and experiment is completed, you can plot the results, print the results, or copy the results
for pasting them into some other application (e.g., to prepare a report). For information and these
features of experiments see Experiment Report.

8.1.1. Experiment Window

      The Experiment Window lists all the files in the currently open experiment. It also lists the
number of chains that have been simulated for each file in the experiment. A blank Experiment
Window will appear when you use the New Experiment... command in the Experiment
Menu. If you use the Open... command in the File Menu and open an existing experiment, an
Experiment Window for that experiment file will open.
      You can resize, move, or scroll the Experiment Window to view any simulation file name in
the current experiment. You can click on any simulation file name to select it. Once a simulation is
selected, its’ Simulation Results Window can be opened using the Open Selected command, it
can be deleted using the Remove command, or you can enter a brief description using the Get
Info... command. An alternative way to open the Simulation Results Window for a particular
simulation is to double click on the simulation name.
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Viewing a Hidden Experiment Window

     During simulations it is common for the Experiment Window to become obscured behind the
Simulation Results Window or the Plot Window. Use the Show Experiment command to
bring the Experiment Window to the front.

8.2. Experiment Report

      You use the Experiment Report... command in the Experiment Menu to view the results
of an experiment (see Lattice Experiments. You can plot the results, print the results in a table, or
copy the results to the clipboard for pasting into other applications.
      After selecting the Experiment Report... command you will get the report dialog box.
The left half of the dialog box lists all the results tabulated in the simulation results window and one
user-defined result (see below). The right half of the dialog box lists most of the possible
simulation parameters. The first two parameters are user-defined parameters and these will be
discussed below. You should select the results you want to view by clicking on items in the list on
the left side of the dialog box. You can select more than one result by holding down the shift key
and clicking. You then select one variable by clicking on one item in the list on the right side of the
dialog box. Normally you will select the one variable that changes from simulation to simulation in
the current experiment.
      After selecting the desired results and the one desired variable, you can plot, print, or copy the
experiment results by clicking on the Plot, Print, or Copy buttons:

Plot
      Selecting this option will plot each selected result as a function of the selected variable. The plot
will appear in the Plot Window and replace any previous plot that may have been in that window. If
you selected more than one result from the list on the left side of the dialog box, the plot will have
multiple curves — one for each selected result. A key across the top of the plot will indicate which
symbols corresponds to which plotted quantity. If you have a color monitor, the separate curves,
symbols, and labels in the key will appear in distinguishable colors.
      When plotting experiment results you have some additional options in the report dialog box that
alter the type of plot produced:

1. Log axes: Two check boxes  (“Log Y Axis” and “Log X Axis”) can be used to make the x
axis, the y axis, or both axes logarithmic. You can use these check boxes to produce semi-log or
log-log plots.

2. Linear Fits: A check box requests linear fits to each result plotted. When this box is checked
each result will be plotted along with the best fit line through the data. The slope and intercept of the
line will also be displayed on the plot. You will probably find that linear fits are most useful when
using semi-log or log-log plots.

3. Overlay Plot: If you request consecutive plots using the same variable from the list on the right
side of the dialog box, you will have the option of overlaying those plots. When the “Overlay Plot”
box is checked, the results in the previous plot will be plotted along with the newly requested plot.
The overlay option is most useful for comparing results of one experiment to those of another
experiment. You begin by opening an experiment file and plotting the results using the experiment
report option. To compare this plot to the plot from another experiment, open the other experiment
and request another plot against the same variable. By checking the “Overlay Plot” check box
when requesting the second plot, you will get a plot that compares the results from the two
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experiments. You can repeat this process to compare the results to three or more experiments.

Print
      Selecting this option will print the selected results on you printer. The output will be in the form
of a table listing the selected experiment parameter on the left side and all selected results on the
right. One column of results will be printed for each result selected. The printed output will also
give the experiment file name, the date printed, and the short experiment description that can be
entered using the Experiment Comments... command in the Experiment Menu. The
printed table will be sorted according to the numeric value of the experiment variable. You therefore
do not have to worry about the order in which you add simulation files to the experiment file.

Copy
      This option is similar to the print option except that the data from the table is copied and placed
in the clipboard instead of being printed. You can paste the copied table into the Scrapbook or into
any application that accepts pasted text. This option is most useful for transferring experiment
results to lab reports. The pasted table will be tab delimited and it should be possible to create a nice
looking table by setting the tab stops of your text processing application to appropriate locations.
As in the print command, the copied table will be sorted according to the numeric value of the
experiment variable.

User-Defined Parameters
 
     When requesting experiment reports, you can get plots, print results, or copy results as a
function of one of the parameters listed on the right side of the report dialog box. The list of
parameters includes most of the parameters that can be set by Lattice (see Setting Simulation
Parameters). In some experiments, however, you may want to view results as a function of some
combination of parameters or as a function of some parameter that is not listed in the report dialog
box. You accomplish this view mode by using User-Defined Parameters.
      Each experiment file has two user-defined parameters. When a new experiment is started the
two parameters are called “User 1” and “User 2”. When you are using user-defined parameters,
you should change the name of one of both of the user-defined parameters to something more
descriptive of the desired parameter. You can edit the names of the two user-defined parameters by
using the Experiment Comments... menu command in the Experiment Menu. The user-
defined parameter names will appear at the top of the list of variable on the right side of the report
dialog box and can be selected like any other parameter when requesting an experiment report.
      A sample user-defined parameter might be “Simulation Volume” and it could be used to enter
the volume allocated to simulations using a  Restricted Chain Space. The standard experiment
report parameter list does not include any chain space parameters. If you want to run an experiment
as a function of some chain space parameter, you will have to use user-defined parameters.
      Assigning names to user-defined variables is just the beginning. For a user-defined parameter
to work, you will have to set the numeric value of the user-defined parameter for each simulation file
in the experiment. To set the numeric value, click on the simulation file name in the experiment
window and select the Get Info... command in the Experiment Menu. You will be able to enter
the numeric value for that simulation for any user-defined parameter.
      Eventually you will want to plot, print, or copy the experiment results as a function of one of the
user-defined parameters. To get such a report use the standard Experiment Report...
command in the Experiment Menu and select one of the user-defined parameters that will appear at
the top of the list on the right side of the report dialog box.
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User-Defined Results

      When requesting experiment reports, you can get plots, print results, or copy results that were
calculated by Lattice. By defining a “user-defined” result, you can additionally get report for
other results. A common use for a “user-defined result” is to compare some theory, some
experiments, or someone else's results to the results of Lattice Experiments.
      Each experiment file has one user-defined result. When a new experiment is started the result is
called “Theory/Expt.”. You can edit the name for the user-defined result by using the
Experiment Comments... menu command in the Experiment Menu.
      To be able to plot, print or copy, user-defined results, you will have to set the numeric value of
the user-defined result for each simulation file in the experiment. To set the numeric value, click on
the simulation file name in the experiment window and select the Get Info... command in the
Experiment Menu. You will be able to enter the numeric value for that result in the space provided
near the top of the dialog box.
      Eventually you will want to plot, print, or copy the user-defined results as a function of some
parameter. To get such a report use the standard Experiment Report... command in the
Experiment Menu and select user-defined result in the list of results on the left side of the report
dialog box.
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Chapter 9

Menu Commands

9.1. Apple or Lattice Menus

      MacOS Classic (prior to MacOS X) has an apple menu. There is only one command in the
Apple menu that is specific to Lattice. MacOS X has Lattice menu in addition to an Apple
menu which begins with the About Lattice... command. This menu has other commands
useful for Lattice. Below is the one command in the classic Apple menu and the extra commands
in the MacOS X Lattice menu.

About Lattice…
      This command will give a brief description and copyright information about Lattice. Clicking
on the Help button will bring up the on-line help window. Click OK to return to Lattice. Besides
the Help button in the “about” dialog, you can open the help window at any time by type ⌘?, by
typing the “help” key on extended keyboards, or by using the Help Menu.
      You can get details on using the on-line help by selecting the Instructions menu command
in the More menu which appears in the help window.

Preferences...
      Set Lattice preferences (see Preferences…).

Quit Lattice...
      Quit the Lattice application.

9.2. File Menu

      The File menu commands are described below.

New (Keyboard Equivalent ⌘N)
      Create a new simulation with a blank Simulation Results Window. If the current simulation has
not been saved, you will be given and opportunity to save it before the new window is created.

Open… (Keyboard Equivalent ⌘O)
      Open a saved simulation or an experiment file; Lattice will automatically determine the type of
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file to open after you select the file in the standard Macintosh open-file dialog box. Opening a file
will also load all plot colors and atom dimensions for that simulation.
      If you open a previously saved simulation and the current simulation has not been saved, you
will be given and opportunity to save it before the saved simulation is read into a new Simulation
Results Window. If instead of opening you get the error message “Memory limitations do not
permit reading the simulation in the selected file,” you must do one of two things before that file
can be opened:

      1. Increase the maximum number of bonds allowed to be greater than or equal to 
            the number used in the simulation file you are trying to open.
      2. Increase the histogram density to be greater than or equal to the density used in 
            the simulation file you are trying to open.

These two changes can both be made using the Preferences… command in the Edit menu.
      If you open a previously saved experiment file, any currently opened experiment will be closed
and the new file will appear in an Experiment Window. 

Open Recent
      This submenu will have a list of recently opened files. Select a file to open it again. If the file
has been deleted or move it will not open and will be removed from the list. Use the Clear
Recent command to clear all recent files from the menu. 

Close
      Close the front-most window. If you close the Simulation Results Window and it has not yet
been saved, you will be given and opportunity to save it before its window is closed.

Save
      Save the current simulation results in the file whose name is specified by the title of the
Simulation Results Window. If the name of that window is “Untitled” you will be prompted for a
file name. Saving a simulation file will also save the current plot colors and atom dimensions (see
Color Plots).
      If the front-most window is the Plot Window, this command will save the plot into a PICT file.
Many Macintosh drawing programs (e.g., SuperPaint) can read PICT files. You can  thus open the
plots with another application and edit the plot graphics.
 
Save As…
      Same as Save except that you will be prompted for a file name before the saving begins.

Page Setup…
      Set the various options controlling output to the printer.

Print…
      Print the information in the current front window. If the front window is the Simulation Results
Window or the Plot Window the print out will include the table of simulation results and/or the
current plot (if one is available). If the front window is the Experiment Window, the print out will be
a list of the simulation files in the experiment file. If the front window is the on-line help window,
the print out will be a complete manual for Lattice (the manual is fairly long, so make sure you
really want to print it before clicking OK).

Print Preview…
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      Same as Print but will show the print out in a preview window. You can click the Print button
in that window to actually print it.

Quit
      Quit Lattice. If the current simulation has not been saved, you will be given an opportunity to
save it before quitting. (In MacOS X, the quit command will be in the Lattice menu (see Apple or
Lattice Menus).

9.3. Edit Menu - copying simulation results

      The commands in the Edit menu are used to copy the current simulation results. Copied
results can be pasted into other Macintosh applications. The function of the menu commands are:

Undo, Cut , Paste, Clear
      These commands are not used in Lattice. They are included for use in desk accessories.

Copy Results
      Copy the text results in the current Simulation Results Window. This command will only be
available when the Simulation Results Window is the front-most window. The simulation
parameters and the table of results will be copied. These copied results will be tab delimited and can
be pasted into the scrapbook or into any application that accepts pasted text. Typically these results
will be pasted into word processing software. The tab spacings in the word processing software will
have to be adjusted before the results will appear as they did in Lattice.

Copy Plot
      Copy the most recently drawn plot. This command will only be available when the Plot Window
is the front-most window. The plot may be a polymer chain, a distribution of end-to-end distances,
or the results of Lattice Experiments. Once a plot is copied, it can be pasted into the scrapbook or
into any Macintosh application that accepts pasted graphics. This can be a useful feature for writing
a report on simulation results done using Lattice.

Preferences…
      This command allows you to pick the maximum chain length, adjust the width of the bars in the
histogram plots of end-to-end distance, and to turn dead-end chain warnings on or off. For detailed
information see Preferences….

9.3.1. Preferences…

      This Preferences… menu command in the Edit menu allows you to pick the maximum
chain length, adjust the width of the bars in the histogram plots of end-to-end distance, and to turn
dead-end chain warnings on or off. You should set the maximum chain length to the length of the
longest polymer chain you plan to simulate. Setting the maximum chain length too high will waste
memory and slow down simulations that include the effect of excluded volume.

Histogram Density

     The histogram density number is proportional to the number or bars per inch in the end-to-end
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distance plots. Increasing this number produces more and narrower bars (note: no matter how high
the histogram density number, the bars will never span less than 1 Å of end-to-end distance).
Reducing this number produces fewer and wider bars. The optimal histogram density number is a
subtle function of chain length and average end-to-end distance. With a little experimentation you
will be able to produce attractive end-to-end distance histogram plots for any polymer simulation.
      One confusing aspect of the histogram density is that it only applies to future simulations. Thus
if you open a previously saved file and change the histogram density, that density will have no effect
on the plotting of the end-to-end distances.
      The procedure for picking the best histogram density for a given polymer is as follows:

            1. Set the polymer properties
            2. Pick a histogram density
            3. Generate some polymers
            4. Plot the end-to-end distance
            5. If the plot looks good stop; if the bars are too wide increase the histogram 
                        density and go back to number 3; if the bars are too narrow reduce the 
                        histogram density and go back to number 3.

Dead-End Warnings
 
     A check box in the Preferences... dialog box allows you to ask for warnings when the
chain parameters result in many dead-end chains. Check this box to enable such warnings; uncheck
it to disable such warnings. It is useful to have dead-end warnings to know when most of your
chains are reaching dead ends. In such cases, you will normally want to change your simulation
parameters. In some cases, however, you may want  Lattice  to keep trying to complete chains
despite many dead ends. For such cases you should disable the dead-end warnings. If many dead
ends are being reached, the simulation may become slow and in extreme cases many never complete
any chains without reaching a dead end.

Rein it ia l izat ion

      Whenever you change the maximum chain length or the histogram density, Lattice has to reset
its’ memory. Lattice will in effect shut down and then automatically restart. Before the shut down,
the current simulation will be checked. If it has not been saved you will be asked if you want to save
it before changing the preferences.

Notes

      The current settings made using the Preferences… menu command define the currently
possible simulations. If you attempt to open a previously saved simulation that was run when the
Preferences… settings were different, you may encounter an error. If you get the error
message “Memory limitations do not permit reading the simulation in the selected file,” you must
do one of two things before that simulation can be opened:

      1. Increase the maximum number of bonds allowed to be greater than or equal to 
            the number used in the simulation file you are trying to open.
      2. Increase the histogram density to be greater than or equal to the density used in 
            the simulation file you are trying to open.
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9.4. Options Menu

      The Options menu is used to set the simulation parameters, determine how the simulation
results will be plotted, and select simulations of specific polymers.
 

Setting Simulation Parameters

      The first commands are

            Polymer Chain… (Keyboard Equivalent ⌘P)
            Weighting Factors… (Keyboard Equivalent ⌘W)
            Vinyl Polymers… (Keyboard Equivalent ⌘A)
            Copolymers… (Keyboard Equivalent ⌘B)
            Temperature… (Keyboard Equivalent ⌘T)
            Excluded Volume… (Keyboard Equivalent ⌘E)
            Restricted Chain Space… (Keyboard Equivalent ⌘R)

These commands are used for Setting Simulation Parameters.

Selecting Plot Options

     The next set of commands are

            Plot Polymers…
            Plot Distribution
            Fit Plot in Window (Keyboard Equivalent ⌘F)
         Plot Colors...
These commands are used to set the plot options. For more information see Plotting Simulation
Results.

Selecting Specific Polymers

      The remainder of the commands in the Options menu are for specific polymers. Selecting
one of these commands will invoke a dialog box which shows the structure of that polymer and a
brief description of how to simulate that polymer. There are two buttons in the specific polymer
dialog box. One button is Set Polymer Properties. Clicking this button will set the
required parameters to begin a simulation of that polymer. The other button is Cancel. Clicking
this button will dismiss the dialog box and not change any of the current parameters.
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9.5. Control Menu

      The Control menu is used to stop and start the simulation. The function of the commands are
as follows:

Start
      Start a simulation using the current chain properties (see Setting Simulation Parameters). If the
properties have been changed since the last simulation, the last simulation will be closed and a new
simulation will begin. If the last simulation was not saved, you will be given an opportunity to save
it.
      After each polymer chain is generated, the table of simulation results will be updated. If one of
the plot options is checked (See Plotting Simulation Results), a new plot will also be generated after
each chain. For the fastest possible simulation disable the plotting. To disable plots, reselect the
checked plot item in the Options Menu.
      Finally, if Start does not start the simulation, you probably have the number of chains set to a
number less than or equal to the number of chains that have already been generated. To generate
more chains, change the number of chains requested to a number larger than the number of chains
that have already been generated.

Stop
      Once a simulation or experiment run begins, this menu command becomes activated and it is
used to stop a simulation or an experiment run before it reaches the number of chains requested.
      Lattice only checks the mouse status during the period of time between generated polymer
chains. To invoke the Stop command using the mouse you should press and hold the mouse
button on the Control menu label. When the next polymer chain is completed the Control
menu will be activated and you can select the Stop command to stop the simulation. Alternatively
you can use the keyboard equivalent to the Stop command which is “⌘.”. When you type this
keyboard command, it will be logged into the keyboard queue and the simulation will stop after the
next polymer chain is completed.

One More Chain
      This command is identical to the Start command except that the number of chains requested
is automatically set to one more than the number of chains already generated. As a result the
simulation will begin, and one and only one chain will be generated. If some of the simulation
parameters have been changed since the last chain was generated, the current simulation will be
closed, a new simulation will begin, and one and only one chain will be generated. As with the
Start command, if the parameters have been changed and the current simulation has not yet been
saved, you will be given an opportunity to save it or to cancel the One More Chain command.

9.6. Experiment Menu

      The commands in the Experiment menu of for working with Lattice Experiments.

New Experiment...
      Create a new experiment file. You will be asked to supply a file name using the standard
Macintosh save file procedure. The file must be saved in the same folder as the simulation files that
will be added to that experiment. The new experiment will open and a blank Experiment Window
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will appear on your screen. To open a previously saved experiment file you can use the Open…
command in the File Menu.

Show Experiment
      Bring the experiment window for the currently open experiment file to the front. This command
is useful when the Simulation Results Window or Plot Window obscures the experiment window.

Experiment Report...
      This command is used to view the results of an experiment. You can plot the experiment results
as a function of any simulation parameter, print a table of the results on your printer, or copy a table
of results for pasting into another application. The details of the experiment reporting options are
described in the information titled Experiment Report.

Experiment Comments...
      Use this command to enter a brief description of the current experiment. You can also enter two
optional labels for user-defined parameters and one optional label for a user-defined result (see
Experiment Report). Any description you enter will be appear on printed output generated by the
Experiment Report... command.

Add...
      Use this command to add simulation files to the currently open experiment file. You will select
files using the standard Macintosh procedure. You will select one file at a time and you can keep
selecting files until you are done. After selecting the last file click Cancel button to exit the file
adding mode. All files added must be in the same folder as the saved experiment file.

Remove
      To remove a simulation file from the current experiment file click on the simulation file’s name
in the experiment window and select this command.

Get Info...
      To edit the “info” for any particular simulation in the currently open experiment file, click on
that simulation file’s name and select this command. You will be able to enter a brief description of
the simulation file and to enter numeric values for the user-defined parameters and the user-defined
result (see Experiment Report). 

Open Selected
      This command will open the simulation results window for the currently selected file in the
experiment window. Alternatively, you can open any simulation by double clicking on that
simulation’s name in the experiment window.

Run...
      Use this command to run the experiment. You will be asked to supply the number of chains
desired for each simulation. Lattice will then automatically open each simulation file and continue
the simulation until it reaches that number of requested chains. An experiment run might take a long
time, but you can interrupt one in progress at any time by using the Stop command in the Control
Menu or by using its keyboard equivalent of ⌘..
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9.7. Help Menu

      The Help menu is used to access the Lattice help. The commands are:

Lattice Help
      Open the help window starting with the help table of contents

Lattice Home Page
      Open the Lattice home page in your default browser.

Help Topics
      The rest of the Help menu commands are the main topics in the on-line help. Select any option
to open the help window and view that help topic.

Help Window

      See the Instructions menu command in the More menu for more information on using the
help. You can print all the help information by using the Print... command when the help window
is the front window.
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Chapter 10

Miscellaneous

10.1. Developer

The application Lattice  (© 1988-2003, All rights reserved) was written and documented by:

      PROFESSOR JOHN A. NAIRN
      UNIVERSITY OF UTAH
      MATERIALS SCIENCE & ENGINEERING DEPT
      122 S CENTRAL CAMPUS DR RM 122
      SALT LAKE CITY, UT 84112-0560
      USA

      Email: mailto:John.Nairn@m.cc.utah.edu
      Phone: +1-801-581-3413
      FAX: +1-801-581-4816

      Lattice Home Page: http://www.mse.utah.edu/ nairn/RSAC/LATDHome.html
      Nairn Web Page: http://www.mse.utah.edu/ nairn
      Department Web Page: http://www.mse.utah.edu
      University Web Page: http://www.utah.edu
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